
FastLook

 LAN
License

This guide is intended to help you  install  the
FastLook LAN version.

Please refer to the electronic help file for more
details on the operation of FastLook.
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Overview
The FastLook LAN version is to be installed on a server.  All
program files will reside on the server.  Each user you wish to have
access to the software must run a simple User Setup program that
places configuration settings and a set of icons on their machine.

When the user runs FastLook from his machine, the software will
look to the server for a license.  If there is no license available, the
user will get a notice so stating and will be asked to try again later.
When the user shuts down FastLook automatically releases the
license for future use.

The administrator has the option to specify their own default
configuration for deployment.  Please refer to the section labled
Creating User Settings Template under Client Installation later in
this guide.

The Administration Module allows the Network Administrator
to control access by password, set user's rights and set global
print options. Refer to the Administration Module section for
more information on setting user rights.

Server Installation
The LAN version must be installed onto a network drive. We
recommend that you install FastLook from the administrator's
computer.

1.   Insert the CD-ROM into the CD-ROM drive.

2.  The Setup screen will appear automatically if you have the
AutoRun feature enabled.  If the Setup screen does not
appear, run the SETUP.EXE located in the root of the CD-
ROM.

3. Follow the on-screen instructions to begin install.

4. Read the License Agreement, check "I agree" and press the
Next button.
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5. Select the File Types you wish to view with FastLook from
the list provided.  You may select all by clicking on the
"Select All Formats" link, or select only the types you wish
by clicking on the checkbox to the left of the file type
description.

6. Please specify the folder in which the FastLook program
files will be copied by the installation program.  Setup will
create two folders under the main FASTLOOK folder.

FASTLOOK\EXE - The FASTLOOK\EXE folder will
contain all of the program files, and must be sharable.  You
may make this folder read- only if you wish to protect the
program files.

FASTLOOK\NET - All users intending to use FastLook
must have READ/WRITE/DELETE/CREATE rights to the
FASTLOOK\NET folder.  These files must also be sharable.

Note: FastLook  will not run if the user does not have the
correct network rights to this folder.

7. Choose a group to use to store the FastLook icons or
accept the default group.

8.  Click Finish to install.

    9. When the install is complete, you will be given the option
to launch FastLook.

10. Please refer to Client Installation for a discription of the
next steps to complete the installation.
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Client Installation
To complete the installation process, you must run the User Setup
Program on each client computer.  This will install configuration
settings and a set of icons on the user's machine.

In addition,  you must include the server as a Trusted Site from the
Internet Properties dialog.

If you wish to provide each new user installation with your own
configuration, i.e. toolbars, font path, etc., read the section named
Creating User Settings Template.  If you simply wish to install the
FastLook viewer with factory default setting skip this next section.

Creating User Settings Template
FastLook provides the user with many configurable options.  If
you elect to change the default options, these changes are saved
in the FLUSER.INI.  The ini is located in the C:\Documents and
Settings\%USER%\Local Settings\Application Data\Kamel
Software\FastLook 2009 folder

If you wish to customize any of the user configurable options for
your network users, follow these steps.

1. You must first install the FastLook viewer software on a
client machine by following the instructions in the section
entitled Installing Client Software.

2. After installing the FastLook viewer, run the program and
make your setting changes.

3. Press the  Save Options  command under the Options Menu
to save these settings.

4.  Next, copy the FLUSER.INI file into the FastLook/EXE
folder located ON THE SERVER.

This will cause the User Setup to automatically use the settings
contained in this INI file as the default template for setting
program options for all subsequent client user installations.



Installing Client Software
The User Setup Program, named USER32.EXE, is installed with
the program files in the FASTLOOK\EXE  folder.  Please read
about automatically configuring user settings via a template
before proceeding.

1. Simply have each user run the User Setup Program.
If you have created a User Settings Template , please
skip to Step 4.

2.  Select the File Types you wish to view with FastLook from
the list provided.  You may select all by clicking on the
"Select All Formats" link, or select only the types you wish
by clicking on the checkbox to the left of the file type
description.

3. FastLook will normally open the help file from the installation
folder. Security options may not allow the help file to run
from the server.  In this case, you may opt to install the help
files locally in the Windows help folder.

4. Choose a group to use to store the FastLook icons or
accept the default group.

5.  Click Finish to install.
6. When the install is complete, you will be given the option

to launch the FastLook program.

Set FastLook as Trusted Site
After running the client install you must include the FastLook
server  as a Trusted Site.

1. Access Control Panel.
2. Open the Security Center.
3. Open the Internet Options dialog.
4. In the Internet Options dialog, click Security, then click

Trusted Sites and press the Sites button.
5. In the text box labeled "Add this website to the zone" type

in the server share name and click the Add button.  Make
sure the  "Requite server verification" option is unchecked.

6. Click  the Close button in the Trusted Sites dialog, then OK
in the Internet Options dialog.
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Administration Module
The Administration Module allows the Network Administrator
to control access by password, set user's rights and set global
print options.  The computer from which the FastLook software
was installed will have a shortcut  to run the Module
(ADMIN32.EXE).  This utility is installed with the program files
in the FASTLOOK\EXE  directory.

When the Administrative Control Program is run, the Login
screen  will appear to allow the Network Administrator  to enter
the default password.  The default user name and password is:

User Name: Admin
Password:  supervisor

Always Prompt for Login
This option will present the user with a Login screen when
FastLook  is run.  FastLook will use the User Name, Password and
Rights established in Edit User Configuration.  Disabling this
option will allow full access to all users.

Allows Users to Change Password
This option will allow users to change their own password.
When enabled, a menu item called Change Password will
appear under the File menu in FastLook.

Edit User Configuration

To Add Users

Press the Add button to add a new user.  Enter the User Name
and Password .  You may now assign rights to the new user.
Press Save Changes when you are finished assigning rights to
this user.   To cancel the changes you have just made, press
Cancel and Restore.  Press Save and Exit when finished
adding all users.
The User information is stored in a database named
FASTUSE.DBF, located in the FASTLOOK\NET directory.
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Allow Guest Login

This option will allow any user to sign in as a Guest User
automatically.    When someone attempts to login, and this
option is checked, they may sign in as Guest.  You may assign
rights to the Guest User.  The Guest User may not be assigned
a password and may not be deleted from the database.

Assigning Rights

Rights may be assigned by choosing a predefined group or
selecting a custom set of rights.  You may change rights for a
user by accessing  the desired User Name and changing the
rights in the Rights section.   To select a predefined group, click
the left mouse button on the desired group title.   If a predefined
group does not represent the rights you wish a specific user to
have, you may select a custom set of rights.   A check next to a
right denotes that this right is enabled for this user. Clear
Rights will clear all rights for the individual user specified in
User Name.  Be sure to Save Changes.

Predefined Groups

Administrator Privileges - All rights are assigned,
along with the right to add and delete users from
the database.

Full Access - All right are assigned,  except for the
right to add and delete users from the database.

View  + Edit Link/Redline - Rights include Screen
Config, Printing, Exporting, Launch, View
Redline, Create/Edit Redline, View Link and
Create/Edit link.

View Only - Rights include the  same as  above,
except for Create/ Edit Redline and Create/Edit
Link.
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Edit Global Print Options

Stamp Printout with Redline Warning

FastLook  may be configured to print a Warning if a Redlining
or Linking file exists for the particular drawing or image to be
printed.  You may elect to print the current date, time, filename,
user name, specified text or any combination of these for the
warning.  These combinations may be printed in any one of six
locations on the page.

To create a Stamp
1. Check the Enable checkbox.
2. Select a "Position on Printout" such as "Upper Left".
3. The font may be set for each position by selecting the

Choose Font button.
4. Type any text you wish to print in the Redline Warning edit

box.  You may wish to include one of the stamping variables
in the text string.  To do so, simply press the Insert
Stamping Variables button and choose the desired variable.
A variable may appear in any position in the string.

Text Stamping

FastLook may also be configured to print a Text Stamp on  most
drawing formats.  The Text Stamp is created in the same manner
as the Warning.  A Stamp may be printed in each of six positions
independently.  If the Warning is enabled, the position defined
for the Warning will not be available.  A Global Print Stamp
defined in this section  will take precedence over any Print Stamp
the user has defined locally.
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Global Settings
The FASTLOOK.INI has been supplied in the program folder to
limit many of the most common functions.  These will be global
settings effecting all users. In many instances it may be desirable
to limit ALL user access to various functions, i.e. printing,
redlining, etc..

Edit this file with Notepad or another text editor. If the value is set
to 1, the functionality that the value represents is enabled. Setting
it to 0 disables it. These settings will cause all users to gain or lose
this functionality, regardless if you have assigned rights to
individual users

Setting Corresponding FastLook Command

Copy File/Copy

Rename File/Rename

Delete File/Delete

View File/View and File/Open

Export File/Export

Acad File/Launch

Email File/Send Mail

Print File/Print

RedlinePref Redline Edit/File Preferences

Redline Redline/View Redlining

Link Links/View Links

Configuration Options/Options
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FastLook Features
The following is a very brief outline of some of the features found
in FastLook.  For more information pertaining to the operation of
FastLook, please refer to the Help file.

Configuration
We have gone to great lengths to provide you with the ability to
reconfigure FastLook to suit your needs.  Many options, such as
scroll bars, background color, toolbar options and more, may be
configured under the Options menu.  Use the Save Options
command if you would like to save the current configuration for
future sessions of FastLook.

Finding A File
The Navigation Panel is a collection of tools to help you find and
manipulate files.  When FastLook is first run, the Panel is displayed
in its closed state.  Simply move the cursor over one of the tabs on
the left side of the drawing window to cause the Navigation Panel
to slide out for use. When a file is found, the Navigation Panel is
used to easily pick the file or files to view, print, email, etc..

The Navigation Panel may be placed into one of a number of
modes.   You may switch between these modes easily by accessing
the Tabs.

Files Tab
In the Files Tab the Navigation Panel consists of the tools
necessary to navigate your drives and folders to easily find files.

Last Viewed Tab
The File List will display all of the files you have viewed in the
current session.  Hold the cursor over the filename to display the
entire path.  Exiting FastLook will clear the filenames from the list.

Groups Tab
The lower list box will present the SmartGroups that have been
created.  When you click on a SmartGroup, the file references
contained in the SmartGroup will be displayed in the File List for
your use.  The SmartGroups Organizer is an easy way for
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individuals and workgroups to logically group drawings and
documents together for easy, fast retrieval.  This is a great way
to store and share references to files that you use often or those
that pertain to a specific task or project.

Preview Tab
FastLook allows the user to create a database of thumbnail
images for the files in a folder. These thumbnails may be
selected, viewed and printed.  This database is kept locally for
the user in the Preview sub-folder of the FastLook 2009 settings
folder. Once a folder has been cataloged, it will display the
thumbnails in the Preview Tab.

Views Tab
If the drawing you are viewing contains layouts, sheets and/or
stored views,  this tab will present the names of the views in a tree-
like structure.  You can easily change to another view by double-
clicking on the name.

Layers Tab
If the drawing your are viewing contains layers or levels, the
Layers Tab will present the list of layers and denote the layer's
color and it's status as either on or off.  All of these attributes can
be changed from the tab.  In addition, default layer configurations
can be created, accessed and edited from the tab.

Viewing Files
If you wish to view one drawing or a number of drawings at once,
FastLook is a real time saver.  To view a single file, use the
Navigation Panel to navigate to your drawings folder and double-
click on the filename.  Change the file type mask by using the link
at the top of the panel.

To view multiple files, simply highlight the filenames in the File List,
then either press  the View  button; choose View from the context
menu; or press the Enter key.  The images will be automatically
opened in separate windows.  To automatically tile the new
windows, select the  Auto-Tile New Windows option under the
Options menu.
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Zooming & Mouse Action
One feature of FastLook that will really spoil you is the automatic
zoom window.  When FastLook is not in Select Entity Mode, the
zoom is always active.  All you need to do is press and drag the
left mouse button to outline the zoom window.  When you release
the mouse button, FastLook will zoom to the area you have
specified.

When FastLook is in standard view mode, clicking the right mouse
button, while the cursor is over the drawing window, will cause
FastLook to take a user defined action.  There are three options to
choose, including a pop-up menu, a single command or no action.
You may redefine this action under the Right Click Action section
of the General tab in the Options dialog.

Basic Viewing Functions
The basic viewing functions for manipulating the image are
accessed under the Display menu.  These functions include
various  zoom  commands, pan, image rotation, contrast,
Monochrome Vector, Invert B&W, Change Page (for Multi-page
TIFF), layer, stored views and 3D viewpoint manipulation, and
redraw.  FastLook views many different image types and not all of
these functions are applicable to all images.  Please refer to Help
for details on how to use each of these functions.

Redlining
The redline, or markup, feature allows you to communicate your
ideas by providing a means in which to draw annotations,
corrections and instructions on drawings.  FastLook saves the
redlining entities you create in a separate file, always protecting
the original.  This file is automatically opened and overlaid when
you view a drawing with redlining turned on.  You can later export
a redline file to the same file type as the one you are redlining.

If you wish to set redline file preferences for all your redlining files,
access the Global Redlining Defaults dialog box from Options/
Redlining.   Refer to Help for a detailed explanation.
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OverLook Window
OverLook is an extremely powerful tool for assisting in the viewing
of large CAD and scanned drawings.   Zoom either in the main
window or the OverLook Window and a reticle appears in the
OverLook.  This reticle represents the current zoom state of the
main window in relation to the entire drawing.

Send Mail
Drawings and related files can be easily emailed from FastLook to
a co-worker.  Your mail service must be MAPI compliant.  FastLook
will allow you to set defaults and to select what files to attach.

Compare Drawings
FastLook has the ability to easily compare two revisions of any
AutoCAD .DWG, Intergraph/MicroStation .DGN, HPGL or DXF
drawing files.  The drawings being compared must have the same
extents.  FastLook will display the results of the compare in a
separate compare window.

Printing
FastLook uses your standard Windows printer drivers when printing
or plotting. FastLook has the capability to print a batch of drawings
from a single directory.  Also, FastLook gives you the ability to affect
the printing of Line Widths.  You may even use your AutoCAD PCP
and CTB files.  Printing options may be set under the Options Dialog.
Text Stamping allows you to print date, time and text on your printed
output.  Refer to  Help for more details on printing options.

Measure
FastLook provides the ability to measure  distances and areas on
many graphical formats.  These Measure commands are found
under the Info menu.  The ability to calibrate the Measure units
has been provided specifically for raster formats.

HyperLinking
This very powerful feature allows you to associate almost anything
to "hot spots" on an image.  Linking can be used to create custom
applications like tying detail drawings to an assembly drawing,
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photos, other CAD drawings or supporting documents.  Your
users can access all the documents and drawings relevant to a
process or project, simply by clicking an area on the computer
screen.   "Hot spots" may be associated with documents, drawings,
images, text files, other applications, internet sites and even send
commands to FastLook.

Information from AutoCAD drawings
FastLook has the ability to retrieve Extended Entity Data, Block
Attributes, Object Data and SQL links which are stored in an
AutoCAD drawing.  From the Info menu,  put FastLook in the
entity pick mode that corresponds to the type of data you wish
to retrieve.    Simply pick an entity on the screen and FastLook
will display the data.  If you integrate FastLook with an external
application, such as Visual Basic, FastLook will pass this data
to your application for further processing.  Contact Kamel
Software for more information on this powerful feature.

Auto-Run Feature
To increase the initial response time, FastLook can be config-
ured to run in the background at start-up.  You can turn this
feature on in the General Tab of the Options dialog.  Using
this feature does not use a license until you view a drawing.

Standby Mode
Standby Mode is another feature used to increase response
time.  After FastLook is exited, the program will sleep in the
background until needed.  When in this mode, the program can
be accessed out of the system tray.  No license is used when
FastLook is in Standby Mode.

13



© 1990-2009 Kamel Software, Inc.  All rights reserved.  Printed in the United States of America.
Portions of this product contain Outside In® Viewer Technology   © 1992-2009 Oracle USA, Inc.
Portions of the Professional Version contain 3D InterOp Suite Technology   © 1992-2009 Spatial Corporation.
All other brands, product names or trademarks belong to their respective holders.

Kamel Software, Inc.
2822 Forsyth Road, Suite 102
Winter Park, Florida  32792

Phone (407)672-0202
Fax (407)672-0416

http://www.kamelsoftware.com

Technical  Support
All technical support must be done through the Report a
Problem feature located under the Help menu.  Please use
this feature to access your Priority Maintenance
subscription to update your FastLook.


